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TRENDnet Hive

TRENDnet Hive Overview

What is TRENDnet Hive?

TRENDnet Hive is a cloud management platform that provides a centralized
cloud-based management solution for TRENDnet network devices. TRENDnet
network devices can be connected to the Hive cloud management platform. The
TRENDnet Hive cloud networking solution offers better overall visibility of your
network devices from a single intuitive and easy-to-use cloud interface.

Advanced features supported with cloud networking include event and device
hardware monitoring, traffic statistics, notification alerts, and troubleshooting
tools. Network device provisioning can be accomplished through scheduled or
immediate deployment of batch firmware and configuration updates. Reduce
the time, complexity, and management costs of your network with TRENDnet
Hive.

=

TRENDAET: s Hive

Features

Cloud-Based Management

TRENDnet Hive network cloud manager provides better overall visibility of your
network devices from a single intuitive and easy-to-use cloud interface

Hassle-Free Remote Monitoring

Remote network management support allows you to monitor your network
devices from the cloud with device uptime, detailed logging, traffic statistics,
event snapshots, and device health (processor/memory hardware and PoE
budget utilization)

Intuitive Alerts and Notifications

Choose customized alerts and notifications to be sent based on exceeded
thresholds (CPU/memory) or events (port link status, device offline, switch loop)

Ease of Provisioning

Schedule batch firmware upgrades and configuration updates for deployment
from the cloud for your network devices. Create and customize configuration
files in the cloud and review records of when firmware and configuration update
tasks were carried out

Reduce time and management costs

Reduce maintenance time and costs by moving network device access to the
cloud

Minimal Downtime

Service-Level Agreement (SLA) guaranteed 99.9 percent uptime and service
availability

© Copyright 2018 TRENDnet. All Rights Reserved.
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Hive Pro Features

Features

Multiple Device Management

Multiple Site Management

Supports all selected TRENDnet devices

Supports unlimited number of devices

Device Configuration & Monitoring

Batch Firmware and Configuration Deployment

Notification Alerts

Multiple Tenant Management

Multiple User Accounts

Role-based User Privileges

Google Maps™ mapping service

Disclaimer: Features and specifications are subject to change without notice.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Adding devices to Hive Configure your device for Internet access

. . . Before connecting TRENDnet devices to the Hive management system, the devices must

Hive Compatlble Devices be configured with the proper IP address, subnet mask, default gateway address, DNS

The device models listed below are currently compatible with TRENDnet Hive. You may server settings, and connected to a network for Internet access before devices can

need to upgrade the device firmware to enable TRENDnet Hive. connect to the Hive management system. Devices must always remain connected to the
Internet to ensure they can be managed and monitored from your Hive account.

Web Smart Switches

Example (TRENDnet Web Smart Switch):

Model Hardware Version (H/W) ] . ) o
Note: The following example will provide the steps for configuring the TRENDnet web
TEG-082WS* v2.XR smart switch IP address, subnet mask, default gateway address, and DNS settings.
TEG-204WS* v1l.XR
TEG-284WS* vL.XR 1. Login to the web smart switch management page.
Note: The TRENDnet web smart switch default IP address and subnet mask is
TEG-524WS* vLXR 192.168.10.200 / 255.255.255.0. The TRENDnet web smart switch default user

PoE Web Smart Switches name and password is admin / admin.

Model Hardware Version (H/W) ®
TRENDNET
TPE-1620WS* v2.XR )
TPE-1620WSF* VLXR TPE-2840WS Login
TPE-204US* v1.XR

Usemame
TPE-2840WS* v2.XR
TPE-5028WS* v1.XR
TPE-5048WS* v1iXR Password
TPE-5240WS* v1.XR

*Important Note: Please make sure you have updated TRENDnet Web Smart Switches to
enable TRENDnet Hive capability (firmware version 3.01.XXX or above).

Disclaimer: Supported models are subject to change without notice.

© Copyright 2021 TRENDnet. All Rights Reserved.
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TRENDnet Hive

2. Click on System > L3 Feature > IPv4 Interface.
3. Enter the IP Address and Subnet Mask settings and click Apply.
Note: You may need to login to the switch with the new IP address settings.

IPv4 Interface Configuration

Status Settings

Interface vian1
State Enabled
.

IP Settings

Get IP Form Static
IP Address 192.168.10.200

Subnet Mask 2552552550

4. Click on System > L3 Feature > IPv4 Static/Default Route.

5. Make sure Default Route is checked, enter the default gateway IP address in
the Next Hop IP Address field, select Primary for the Backup Up Status, and
click Apply.

IPv4 Static/Default Route

1Pva Static/Delaull Houte

1P Agdress B Delaut Route

[EHES

et e Ipic‘:lqs‘s

Backup Stalus I [ ¥ J I

6. Click on System > DNS.
7. Enter the DNS server IP address in the DNS IPv4 Server field and click Apply.

DNS Server Settings

DNS Server Settings

DNS IPv4 Server: 8888

DNS IPv6 Server

In the top right menu, click on the save disk icon to save to NV-RAM.
Note: You can also click on Save in the left navigation menu and click on Save
Settings to Flash.

After your switch has been configured with the proper IP address and DNS
server settings, connect your switch to your network with Internet access.
Note: After you have connected your switch to your network, you can verify
Internet access by conducting a ping test from the switch in the left navigation
menu Tools > Ping and for the Destination IP Address, enter an Internet IP
address such as 8.8.8.8, click Start. After a few seconds, click Show Ping Result
button when it becomes available to check the result. The pass result should
have a value higher than 0% to indicate that the switch can access the Internet.

Ping Test Result

Ping Test Result

Result

Destination IP Address: 8.8.8.8
Pass: 100%

Average Time: 40 ms

© Copyright 2021 TRENDnet. All Rights Reserved.
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3. For the Cloud Mode, select Enabled.
4. For the Registration, select Enabled
5. Enter in your Hive account credentials in the User Name and Password fields,
After your TRENDnet device has been properly configured and and connected for then click Apply
Internet access, reglster_ your device W|t_h your Hive accou_nt by logging mtf) your deylce Note: Once the device is assigned to a specific Hive user account, the device
management page and in the cloud settings, enter your Hive user credentials to register . . .
. . . cannot be assigned to a different Hive user account.
your device with your Hive account.

Register your device with your Hive account

Cloud Settings

Note: The following example will provide the steps for registering the TRENDnet web Cloud Mode Enabled
smart switch to your Hive account.

Status Disconnect
1. Login to the web smart switch management page. i
) ) Registration Enabled
Note: The TRENDnet web smart switch default IP address and subnet mask is
192.168.10.200 / 255.255.255.0. The TRENDnet web smart switch default user User Name
name and password is admin / admin. Password

]
@
T RE nDnET Note: The Hive icon will turn green along with a status message update after
the switch has been successfully registered.
TPE-2840WS Login

Usemame Status Connect Success

Password . ) L.
6. Inthe top right menu, click on the save disk icon to save to NV-RAM.

Note: You can also click on Save in the left navigation menu and click on Save
Settings to Flash.

2. Inthe top right menu, click on the Hive icon.
Note: You can also click on System > Cloud Settings in the left navigation menu.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Hive Management Portal

This section will explain how to navigate, functionality and usage of the Hive management portal .

Login to your Hive account

Using a web browser, login to your Hive account at https://cloud.trendnet.com. Enter your user name and password account credentials and click Login.

TRENDNET <& Hive

Register New User

© Copyright 2021 TRENDnet. All Rights Reserved.
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Hive Dashboard

The Hive dashboard displays the total number of tenants, devices (online/total) and the number of alarm notifications.

You can also create new tenants, remove tenants, check tenant location, check the alarm notifications and online/total number of devices for each tenant from this page.
Note: Devices must be assigned to tenant in order the devices to be managed from Hive.

What is a tenant in the Hive Management System?

A tenant is group in the Hive Management System for easier manageability of network locations, customers, or organizations where TRENDnet Hive compatible devices will be installed,
monitored and managed. Tenant management will allow for better organization, maintenance, monitoring of each network location, customer, or organization individually. Additional
users can be created for Hive access and restricted only to a specific tenant and restricted only to specific management sections for the specified tenant for access control purposes.

Alarm - Displays the number alert

Online/Total Devices - Displays the notifications. Click to view alerts.

number of devices online/total number of
devices. Click to view devices.

Tenant — Displays total number of tenants

TRENDNET < Hive

= Tenant I  Oniine/Total Devices é Alarm
2 Devices ——
=m Hl s 586

#  Configuration
Firmware & List | @ Map

A A
O License #| Tenant Alarm Switch Operation
Monitoring Mo Data

Maintenance Totall0 10/page n Goto 1
Add Tenant - Click to add a new tenant. List | Map — Click List to display tenants in list

view, click Map to display tenants by location
on map. You can also view device location by
entering the device MAC address.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Create a new tenant

Click + = or in the top right menu, click to create a new tenant.

In the Add Tenant window, enter the Name and Location of the new tenant.Then click m to create the new tenant.

Mame

Location

The new tenant will be displayed in the tenant list.
# Tenant Alarm Switch Operation

1 TENANTA 0 0/0 g B m @ g

e Tenant - Displays the tenant name.

e Alarm - Displays the number of alerts for this tenant.

e  Switch — Displays the number of switch devices online / total number of switch devices for this tenant.
e  Operation

7
4 . .
o Edit tenant name and location.
ES| ) . . . .
o View available devices and assign devices to the tenant.
]
o Delete or remove the tenant.
-'FI
o ‘”’ View tenant location on map.
L]
o View tenant device topology.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Manage devices in your Hive account

After you have registered your device with your Hive account from the device management interface, the device will be available in your Hive management portal.

To view newly registered devices in your Hive management portal, in the left navigation menu, click on Devices and click on Device List.

In the top left drop-down list, select Unused to view a list of devices that have not been assigned to tenants.

Note: The drop-down list will also allow you to select and view tenants which will display a list of devices assigned only to the selected tenant.

Unused

The Unused list will display a list of available devices and device information.

Switch

# Status Authorize Status Model MAC Alias SN

FW Version Operation
1 = :‘7) Authorized TEG-082W3 OO0 0000000 00000000000 HIOCNNK, 3.01.007
2 = EZ Authorized TPE-1620WS XU XXX 00000000000 HOOOOOOO000K 3.01.007
3 = (@) unauthority CEEFD) TPE-082WS XK DO XX-XX-XX XOOOOOKKNNKNK XHOOOOCKKNNKNK 3.01.007
e Status

8

This icon will indicate that the device is registered to the Hive account but is currently offline.

Note: Devices that are offline can be assigned to a tenant but cannot be managed, monitoring, or configured. Please ensure that the device has the correct IP address,
gateway, and DNS configuration, and there are no issues preventing the device from reaching the Internet at the installed location. Additionally, you have configured the
cloud settings in the device management page and registering your device with your Hive user credentials.

E

o This icon will indicate that the device is registerd to the Hive account and is currently online.

© Copyright 2021 TRENDnet. All Rights Reserved.
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TRENDnet User’s Guide

e Authorize Status

[Ej Unauthority @0

o
This indicates that the device does not have an active license subscription assigned. Click Assign to assign a valid license key to activate the device subscription.
Note: Devices require an active license subscription in order to use with the Hive Management System.

I Assign license
" Type Switch
* License
Device OO0
—— B
\v) Authorized
o

This indicates that the device has a valid active license subscription assigned and is authorized for use with your Hive account.

e Model - Displays the device model number.

e MAC - Displays the device MAC address.
Alias — Displays the device name or label and is customizable. By default, the serial number (SN) is assigned to all devices as the Alias. Click the entry to modify the device alias,

then click OK. Note: It is recommended to change the device alias so that the device is easily identifiable in the Hive management system.

Modify device alias X

Alias OO0

© Copyright 2021 TRENDnet. All Rights Reserved.
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e SN - Displays the device serial number.
e  FW Version — Displays the device firmware version.
e  Operation — Click the drop-down list to select which tenant you would like to assign the device.

Operation

TENAMNTA

B
Note: You can also assign a device to tenant under Dashboard and under Operation, click the edit button to select which devices to assign to the tenant.

To view the locations of registered devices in your Hive management portal, in the left navigation menu, click on Devices and click on Device Location. You can also view the location of
specific device by entering the device MAC address. (Format: XX-XX-XX-XX-XX-XX or XX:XX:XX:XX:XX:XX)

2/4

Switch: Online/Total

BRITISH
. COLUMBIA SASKATCHEWAN A
Map Satellite M
ONTARIO QUEREC
Seattle s
o NORTH N
WASHINGTON MONTANA DAKOTA =3 4 NB
Pcrganﬂ MINNESOTA Dttawa oMnntreal
Rl EMAINERN ovalSCOT A
s0UTH WISCOMNSIN / ; NOVAISCOTIA
oeTEe DAKOTA == ol Toronto - VIl
OREGON oy > o) MICHIGAN! I N
WY OMING . = NEW YORK
Chicago A : MA
‘ | < s CTiR
INO|S OHID PENMN o
" United States INDIANA Ty, Lo
San Francisco EELSRAnY KANSAS' M iSSOUF
o
ALIFORNIA- o) as Vegas Y KLAHCMA
Los @eles ARIZONA ARKANSAS
NEW MEXICO TR e
San Diegoo
North 2.0
Pacific Lo AN A
Ocean =
Houston
FELORIDA
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Configure devices in your Hive account

After you have assigned your devices to a tenant, you can apply configuration settings to your devices in your Hive management portal in the left navigation menu, click on Devices and

click on Device List.

In the top left drop-down list and select the tenant to display the list of assigned devices.

In the example below, TENANT1 has been created and will be selected for this example.

Unused

TEMAMNTA

Unused

Under TENANT]1, the assigned device (TRENDnet Web Smart Switch Model TEG-082WS) will be displayed with the device information.

Switch

# Status Authorize Status Model MAG Alias SN
1 8 () Autnorized TEG-082WS XX XXX XK TEG-082WSv2 00000000

B

To apply configuration settings to the device (TEG-082WS), under the Operation section, click the edit button

Note: To remove the assigned deivce from the tenant, click the trash button = .

Additional device information can be displayed by clicking the filter table icon at the top right of the table.

FW Version Operation

3.01.007 B

Filters: Status, Authorize End Time (Device License Expiration), Model, MAC, Alias, SN, Public IP, Local IP, FW (Firmware) Version, HW (Hardware) Version, Startup Time, Power

Consumption, Power Budget, Last Seen, CPU Usage, Memory Usage.

© Copyright 2021 TRENDnet. All Rights Reserved.
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The available device configuration settings will be displayed.

Note: Please refer to the device User Guide for additional information on the device configuration settings.

e Displayed below are example configuration pages from TRENDnet Web Smart Switch Model TEG-082WS

e To apply configuration changes for Hive supported Web Smart Switches, modify the device configuration settings and click Submit.

e The Version Comparison function for Hive supported Web Smart Switches, will allow you to compare the current switch configuration with new configuration file created in the
Hive management system for provisioning.

Basic Configuration

Information

Tenant:
Alias:
Configuration Version:

Version Comparison

Basic Information

Starting Time:
Runtime Image:

Boot Loader:

IPv4 Information

MAC Address:
IP Address:
Subnet Mask:

Default Gateway:

w
@

TENANT1
TEG-082W3sv2

N/A

20 day(s).2 hr(s).54 min(s),47 sec(s)
3.01.007

1.00.011

DK== O XOK- XX
192.168.10.241
255.255.255.0

192.168.10.254

Image Select

Next Boot Image ID:
Running Image 1D:
Image1 Version:

Image2 Version:

IPv6 Information

IPv6 Unicast Address / Prefix Length
IPvE Default Gateway:

Link Local Address / Prefix length:

Hardware Information

HW Version:
DRAM Size:

Flash Size:

=3 =3 BT

© Imagei Image?
Image1
3.01.007

3.01.005

MIA
MIA

N/A

V2.0R
256MB

32MB

© Copyright 2021 TRENDnet. All Rights Reserved.
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o
@
5

Basic Configuration Network Syste

| Jejofafsfofrfel

Real-Time Statistics (packets)

Port: 1 Unicast Receive{Rx): 0 Unicast Transmit(Tx): 0
Total Receive(Rx): 0 Multicast Receive(Rx): 0 Multicast Transmit(Tx): O
Total Transmit(Tx): 0 Broadcast Receive(Rx): 0 Broadcast Transmit(Tx): 0

24-Hour CPU & Memory Utilization

—@- CPU —@ Memory

M

2021-02-04 17:54:26

Log Record
Device Record Configuration Log
# Log Content Create Time
1 Update device lldp data 2021-02-04 18:29:47
2 Update device lldp data 2021-02-04 18:02:09

=3 3 1 3

To view newly registered devices in your Hive management portal, in the left navigation menu, click on Devices and click on Device List.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Provision devices in your Hive account

Devices in Hive can be provisioned through configuration and firmware upgrades.

Configuration Provisioning

To provision device configuration, configuration files must first be created in the Hive Management System. Batch configuration provisioning tasks can only be deployed for single
TRENDnet device model. (Example: Multiple TRENDnet TEG-082WS or multiple TPE-082WS switches but not both models for a single provisioning task.)

To create a new configuration file, in the left navigation menu, click on Configuration and click on Create.
In the top left, click the drop-down list to select the type of device to create a new configuration file and click Add.

In the example below, we will create a new configuration file for the TEG-082WS.
SI" Illitcn

For the new configuration file, first configure the SNTP/Time Settings under System > System Time.

]
7,
i
=
a1

© Copyright 2021 TRENDnet. All Rights Reserved.
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If configuring SNTP, under Date/Time Settings, click the Clock Mode drop-down list and select SNTP.

In the Simple Network Time Protocol (SNTP) Settings, enter the SNTP Primary Server, SNTP Secondary Server as an IPv4 address, IPv6 address, or Domain Name and in top right. In the
Additional Time Parameters section, click the Time Zone drop-down list and select the correct Time Zone and enable and configure your daylight savings time, if any, then click Submit.

Date/Time Settings

Clock Mode SNTP

Local Time Settings

Date Settings: / ! (YYYY:MM:DD)

Time Settings : (HH:MM:35)

Simple Network Time Protocol (SNTP) Settings

SNTP Primary Server: IPv4
SNTP Secondary Server IPv4
SNTP Poll Interval: 1 Min{1-60)

Additional Time Parameters
Time Zone: (GMT-08:00) Pacific Time (US & Canada), Tijuana
Daylight Saving Time Status Enabled
From: February 02 00 00 (Month:DayHH:MM)
To: November 01 0o 00 (Month:Day:HH:MM)
DST Offset 1hr
Submit

© Copyright 2021 TRENDnet. All Rights Reserved.
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If configuring Local Time Settings, under Date/Time Settings, click the Clock Mode drop-down list and select Local Time.
In the Local Time Settings, enter the Date Settings and Time Settings. click Submit.

In the Additional Time Parameters section, click the Time Zone drop-down list and select the correct Time Zone and enable and configure your daylight savings time, if any, then click
Submit.

Date/Time Setlings

SMTF Seoondary Semner

{Month:Day HH:MM

{Mtonth Day HEH KM

© Copyright 2021 TRENDnet. All Rights Reserved.
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After you have configured and saved the time and date settings for the configuration file, you can more configuration changes to the configuration file.
After applying all configuration changes for the new configuration file, in the Basic Configuration tab, select Basic Information.

Note: For each configuration change, please make sure to click Submit in the top right after configuration settings have been modified.

Basic Configuration Metwork PoE System Security

Basic Information

Enter a Configuration Name, a System Name, and click the Model drop-down list to select the TRENDnet device model. In the top right, click Submit to save the new configuration file..

Add Switch Configuration Submit
Basic Configuration Network System Securi
* Configuration Name 20210204-websmartcfg-1 " System Name Edge Switch
* Model TEG-082WS
# Configuration Version Model Type Create Time + Operaior Operation
1 20210205-websmartcig-1 1.0 TEG-082WS Switch 2021-02-05 14:32:09 trendnetpm &

7
"= Clicking the edit button will allow you to modify the configuration file.

.

I Clicking the delete button will delete the configuration file.

© Copyright 2021 TRENDnet. All Rights Reserved.
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To provision devices with a new configuration file, click on Configuration and click on Provision.
In the top left drop-down list, select the tenant.

TENANTA

TEMANTAH

Click the Type drop-down list and select the device type. The click the Configuration File drop-down list to select the configuration file.

Type = Switch

* Configuration File

TEG-082WS3S 20210205-websmaricfg-1 1.0

© Copyright 2021 TRENDnet. All Rights Reserved.
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After the configuration file is selected, the applicable online devices for the selected configuration file will appear in the Device/Online Device List.

Check the devices you would like to provision, and click to move the devices to the selected list.

" Device Online Device List

TEG-082W5Sw2

Selected 0/

TEG-082WSv2

Click the Provision Option drop-down list to select when to provision selected devices with the configuration file. After you have selected this desired option, click Submit.
e  Start execution now - Selecting this option will execute the task immediately.

e Select execution time — Selecting this option will allow you to schedule a future date and time when to execute this task. Configure the date and time schedule when to execute
this task and click OK.

Note: If scheduling this task, checking the option to Send email reminder after task execution will send an email notification.

Provigion Option | Start execution now

Start execution now

Select execution time

© Copyright 2021 TRENDnet. All Rights Reserved.
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After creating a scheduled configuration task, the task will be listed under Configuration > Schedule from the left navigation menu.

o Configuration Operator Version Create Time Execution Time Task Status ~ Operation

1 20210205-websmartcfg-1 OO0 1.0 2021-02-05 14:49:58 2021-02-05 15:00:00 Waiting g o

e Configuration — Displays the configuration file name.
e  Operator — Displays the user that created the task.
e Version - Displays the configuration file version.
Note: If the original configuration file is modified under Configuration > Create section, a new version of the configuration file is created and the system will automatically update
the version number. (Example: 1.0, 2.0, 3.0, etc)
e Create Time — Displays the date and time the scheduled task was created.
e Execution Time - Displays the date and time the task is scheduled to be executed.
e Task Status — Displays the current task status.
o  Waiting — Indicates that the scheduled task is pending to be carried out until the scheduled/Execution time is reached.
o Execution - Indicates that the scheduled task has already been completed.
e  Operation

/7
"= See task detail.

©
Cancel the task.

e

' After a task is cancelled before the schedule date and time, you can restore or restart the task.

Ej

After tasks are executed, click this button to view more detail.

After configuration tasks have been executed, you can check the status details under Configuration > Record and in the Details column, click 5 to view more information.

Status List

¥ Alias MAL Update Tirme Slalus

Configuration Upgrade

{ TEG-082WSv2 W -KH-M-O-0-HK 2021-02-05 17:30:19

© Copyright 2021 TRENDnet. All Rights Reserved.
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Firmware Provisioning

Standard device firmware will be released by TRENDnet periodically and be available within the Hive Management System for provisioning and can be found under the Firmware >
Information section from the left navigation menu. You can check the current firmware version of devices under Devices > Devices List.

Note: Only Hive compatible device firmware releases will be available on the Hive Management System. For previous firmware releases, please download from our website
https.//trendnet.com/support

A system message will be sent out to your Hive account when a new firmware is released. An indicator will appear in the top right menu above the Account/Logging button.

Mouse over the Account/Logging button to view the sub menu and click Message List to view system messages.

Personal Information

User Management

Message List

Device Log

System Log

Logout
All Messages Read Messages Unread Messages
Title Type Status Content Create Time Operation
Release a new version System Message Read Model TPE-5048WS, TPE-204US, TPE-082WS, TPE-1620.. 2021-01-05 15:45:14 B m
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To view the available device firmware releases, in the left navigation click on Firmware and click on Information.

# Model Operator FW Version Check Sum MD5 Create Time

1 TPE-5048WS3 , TPE-204US |, TPE-082W3 | TPE-1620W. .. OO0 3.01.007 582B7577 00a43e727de27280c8367121.. 2021-01-05 15:45:14

Total 1 10/page n Goto 1

e Model - Displays the device model(s) the firmware release applies.

e  Operator - Displays the user account that created the firmware release.

e FW Version - Displays the firmware version number.

e  Check Sum - Displays the firmware file checksum.

e  MD5 - Displays the firmware file MD5 checksum.

e Create Time — Displays the date and time the firmware release was created.

To provision devices with a new firmware image file, click on Firmware and click on Provision.
In the top left drop-down list, select the tenant.

TENANT1

TEMANT1
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Click the Type drop-down list and select the device type. The click the FW drop-down list to select the firmware image file.

Type = Switch

® F Illlﬂljr

* Device  3.01.007

After you have selected the Type and FW (firmware image file), the applicable online devices for the selected firmware file will appear in the Device/Online Device List.

Check the devices you would like to provision, and click to move the devices to the selected list.

" Device Online Device List

TEG-082WSv2

Selected 0/

TEG-082W35v2
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Click the Provision Option drop-down list to select when to provision selected devices with the firmware image file. After you have selected this desired option, click Submit.

e  Start execution now — Selecting this option will execute the task immediately.

this task and click OK.
Note: If scheduling this task, checking the option to Send email reminder after task execution will send an email notification.

Select execution time — Selecting this option will allow you to schedule a future date and time when to execute this task. Configure the date and time schedule when to execute

Provision Option Start execution now

Start execution now

Select execution time

After creating a scheduled configuration task, the task will be listed under Firmware > Schedule from the left navigation menu.

4 FW Version Operator Create Time Execution Time Task Status ~ Operation
1 3.01.007 XXXOOOOOHKNNNK 2021-02-08 16:04'59 2021-02-08 16:07:00 Waiting & e
e FW Version — Displays the firmware version number that will be used to provision devices.
e  Operator — Displays the user that created the task.
e Create Time — Displays the date and time the scheduled task was created.
e Execution Time - Displays the date and time the task is scheduled to be executed.
e  Task Status — Displays the current task status.
o Waiting — Indicates that the scheduled task is pending to be carried out until the scheduled/Execution time is reached.
o Execution — Indicates that the scheduled task has already been completed.
e  Operation
&
~ See task detail.
©
Cancel the task.
=" After a task is cancelled before the schedule date and time, you can restore or restart the task.
B After tasks are executed, click this button to view more detail.
© Copyright 2021 TRENDnet. All Rights Reserved.
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After firmware tasks have been executed, you can check the status details under Firmware > Record and in the Details column, click B to view more information.

Status List X

3 Model Alias MAGC Update Time Status

1 TEG-082W3 TEG-082W5v2 MO OR- XA MOH-XK 2021-02-08 161036 Upgrade Success

© Copyright 2021 TRENDnet. All Rights Reserved.
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Assigning device licenses

Note: Devices require an active license subscription in order to use with the Hive Management System.

After you have purchased a license subscription, you will sent a digital license key depending on the subscription purchased.
After receiving the license key, the key must be added to your Hive account to assign device licenses.

To add purchase a new license key to your account, in the Hive Management portal, click on License and Add License in the left navigation menu.

In the Add License window, enter your license key in the Key field provided and click Submit.

Click Add to add a new license key.

Add License X

Key BEEEEEEEEEG SR L e bbby

Cancel Submit

After you have entered in your license key, the new device licenses will appear in the License List (depending on the license susbscription purchased).

# Key Type Valid time Status Device Start Time End Time Create Time

1 K- XN = OO XK - XK Switch 1085 Day(s) Unused - - - 2021-01-15 14:18:42
2 ORI JOOOK- YK Switch 1095 Day(s) Unused - - - 2021-01-15 14:18:42
3 OO0 00000000000 Switch 1085 Day(s) Unused - - - 2021-01-15 141842
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27



TRENDnet User’s Guide Hive Management System

e Key - Displays the device license key.

e Type - Displays the device type.

e Valid time — Displays the active duration of the device license.

e Device - If the device license is already assigned to a device, displays the alias name of the device.

e  Start Time — Displays the time and date the device license was activated and assigned to a device.

e End Time - Displays the time and date the device license will expire after being assigned to a device.

Note: In the license list, you can search licenses by device type and license status filter fields at top of the page. Click Search m after you have selected to filters.

Switch | Used

Unused
Used
Expired

Bound

To assign an available device subscription license to a devic, in the left navigation menu, click on Devices and click on Device List.

In the top left drop-down list, select Unused to view a list of devices that have not been assigned to tenants.

Note: The drop-down list will also allow you to select and view tenants which will display a list of devices assigned only to the selected tenant. If you already assigned the device to a
tenant, click the drop-down list and select the tenant the unlicensed device was assigned.

Unused
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In the list of devices under Authorize Status, unlicensed devices will have an Assign button. Click on Assign to assign a device license to the device.

Switch
# Status Authorize Staius Model MAG Alias SN FW Version Operation
1 B E’j Authorized TEG-082WS XXX KUK OO0 00000000 3.01.007
> B8 & Auorizea TPE-1620WS XX XHKK-XKXK XH00000000000K XKIOOXO00KK 3.01.007
s B @ Unauthority QXD TPE-082W3 XXX XHUX-DOK-XX OO0 — 501,007

e  Authorize Status

() unauthority CEED)

o
This indicates that the device does not have an active license subscription assigned. Click Assign to assign a valid license key to activate the device subscription.
Note: Devices require an active license subscription in order to use with the Hive Management System.

| Assignlicense
" Type Switch
* License
Device OO
e -
\v) Authorized
o

This indicates that the device has a valid active license subscription assigned and is authorized for use with your Hive account.
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Monitoring devices
Event Monitoring

To monitor device events, in the left navigation menu, click on Monitoring and click on Events.

The Top 10 Device Events tab displays an event snapshot of the top 10 devices that generated the most events in the last 24 hours.
Click the top left drop-down list to select a specific tenant or select All to view devices from all tenants.

Click the drop-down list next to the tenant selection to select the type of event.

The devices will be listed on the left and the bars will display the number of occurrences the event took place.

Top 10 Device Events Device Event Analysis
TENANT1 System

All 'Events
TENANT1

Alias: TPE-2B40W5w2

AliBS: TEG _082\#‘}5‘.{2 _

0 1 2 3 4
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To view more detail on device events, in the left navigation menu, click on the Device Event Analysis tab.
Click the top left drop-down list to select a specific tenant or select All to view devices from all tenants.

Click the drop-down list next to the tenant selection to select a specific device or select All to view all devices.
Click the drop-down list next to the device selection and select the range of dates to view.

Note: Event data is limited to only to 30 days prior to the current date.

Click on Event Type drop-down list to select a specific event or select All to view all events. If none is select, by default, the chart will display all events.

Mouse over the chart to view the specific number of occurrences the events took place on the specific date.

Top 10 Device Events Devic

m
@
1]

TENANT1 All 2021701711 to 2021/02/10

Device Event Analysis

12 4

L1 S ——

2021-01-11 2021-01-14

——

— ¢
2021-01-17 2021-01-20

— o

2021-01-26

et o
2021-01-23 2021-01-29 2021-02-01 2021-02-04

{_} System
~ STP
—_+ Port Link Down
Port Link Up
Loop Status
+ POE Log

AN

12021-02-07

2021-02-10
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Device Utilization

To view device CPU, memory, and PoE utilization (if applicable), click on Monitoring and click on Utilization.

Click the top left drop-down list to select a specific tenant or select All to view devices from all tenants.

The current CPU, memory, and PoE budget utilization will be displayed for the devices.

Hive Management System

TENANT1

CPU Usage Memory Usage
TPE-2840W3v2 e 9% TPE-2840W3v2 64%
TEG-082W3v2 0%

% TEG-082WSv2 e—— 59%

Device POE Usage

TPE-2840W5v2 =

3.84%
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Diagnostic Tools

To access the diagnostic tools, in the left navigation menu, click on Maintenance and click on Diagnostic.

At the top, click the drop-down list to select the tenant to run the diagnostic and click on Start.

Ping IPv4 Host

To run a ping test to check for network connectivity from a device to an IPv4 host, click the Modus drop-down list and select Ping.

e Package Number — Value specifies the number of ping requests to send.
e Package Size — Value specifies the ping packet size in bytes.
e Target — Enter the IPv4 address of the host to send pings to check network connectivity.

In the list, check the devices you would like to run the ping test, click Submit.

Device List x
Modus Ping * Package Mumber 5 " Package Size 20 * Target 0.0.0.0
# Alias Type Model MAC SN
1 TEG-032Wsv2 Switch TEG-032WS XXX -XH-XH-IK-XK JOOOOOOOOOOK
2 TPE-2840WSv2 Switch TPE-2240WS NN IOLININNN JOOOO0OODOO00!
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The submitted diagnostic test will appear in the list.

# Modus Operator Time Operation

1 Ping 000000 2021-02-10 13:48:08 B w

Under Operation

B Click this button to show the test detail.

Click this button to delete the entry.

Under the test detail window, under Details, click view B button for additional test detail for each device.

Detail ~
Alias MAC Update Time Status Details
1 TPE-2840WSv2 LEO PO OS¢ 2021-02-10 13:48:13 Execute successfully B
2 TEG-082WSy2 HOUXKA-XH-HH-XH-XK 2021-02-10 13:48:13 Execute successfully B
Diagnostic Details .

Reply Received From : 192.168.10.254, TimeTaken : 20 ms
Reply Received From : 192.168.10.254, TimeTaken : 10 ms
Reply Received From : 192.168.10.254, TimeTaken : 10 ms
Reply Received From : 192.168.10.254, TimeTaken : 10 ms
Reply Received From - 192 168.10.254, TimeTaken - 10 ms
—- 192 168.10.254 Ping Statistics ---

5 Packets Transmitted, 5 Packets Received, 0% Packets Loss
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Device Reboot
To reboot devices, click the Modus drop-down list and select Reboot.

Check the devices you would like to reboot and click Submit.

Hive Management System

Device List ~
Modus Reboot
# Alias Type Model MAC SN
1 TEG-082W5sv2 Switch TEG-082W5 == K- DK M- 000000000000
2 TPE-2840WSy2 Switch TPE-2840WS 00 XXX XH-XH-KX XXXOONKNK
The submitted diagnostic test will appear in the list.
# Modus Operator Time Operation
1 Reboot 0000000 2021-02-10 14:00:54 B w
Under Operation
B Click this button to show the test detail.
Il
— Click this button to delete the entry.
Detalil ><
Alias MAC Update Time Status Details
1 TPE-2840WS 2 00X XU X06-XX 2021-02-10 14:00'54

2 TEG-082WSv2

XN XOK-DOK-XOK-XK

2021-02-10 14:00:54

Execute successfully

Execute successfully
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Cable Diagnostics
To run cable diagnostics, click the Modus drop-down list and select Cable Diagnostics.

Click the Port drop-down list to select a specific port to run cable diagnostic or select All port to run a cable diagnostic on all ports.
Check the devices you would like to run the cable diagnostic and click Submit.

Device List X
Modus Cable Diagnostics * Port All Port
# Alias Type Model MAC SN
1 TEG-082WSv2 Switch TEG-082WS PSS S FOO0000000000
2 TPE-2840WSv2 Switch TPE-2840WS O HH-XH- XK XK-XK 00000000000

The submitted diagnostic test will appear in the list.

# Modus Operaior Time Operation
1 Cable Diagnostics 000000000000 2021-02-10 14:10:46 B m
Under Operation

B Click this button to show the test detail.

i

= Click this button to delete the entry.

© Copyright 2021 TRENDnet. All Rights Reserved.
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Under the test detail window, under Details, click view button B for additional test detail for each device.

Note: The view button Ei will be available after the diagnostic test has completed.

Hive Management System

Alias
1 TPE-2840WSv2
2 TEG-082WSv2

MAC

0020020 DK-XX-XX

202K XK= XK-XX-XX

Detail
Update Time Status
2021-02-10 1410:47 In execution -
2021-02-10 14:11:03 Execute successfully

Details

7]

Port

Diagnostic Details

Test Result Cable Fault Distance (meters)

Pair 1 Open in
Pair 2 Open in
Pair 3 Open in
Pair 4 Open in
Pair 1 Open in
Pair 2 Open in
Pair 3 Open in
Pair 4 Open in
Pair 1 Open in
Pair 2 Open in
Pair 3 Open in

Pair 4 Open in

Cable Pair10

Cable Pairz2 0

Cable Pair3 0

Cable Pair4 0

Cable Pair10

Cable Pair2 0

Cable Pair30

Cable Pair4 0

Cable Pair10

Cable Pair2 0

Cable Pair3 0

Cable Pair4 0

Cable Length (meters) [in range]
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Account Settings

In the top right menu are the items below. l

Il @ & & 2°

Expand/Collapse left navigation menu

Create new tenant

Select language

Alert notification settings

Account Settings and Logging

TRENDNET “& Hive

-
-

— Tenant I Online/Total Devices é Alarm
Devices ——
mm, El s 677

#i  Configuration

8 Firmware + Add Tenant B List |3 Map

O License #  Tenant Alarm Switch Operation

A /9
Monitoring 1 TENANTT -

Total 1 10/page n Goto 1

I
[

4B W e &

Maintenance

© Copyright 2021 TRENDnet. All Rights Reserved.
38



TRENDnet User’s Guide Hive Management System

Modify Hive Account Settings

To modify your Hive personal account information, in the top right menu, click the Account/Logging button and click on Personal Information.

The Basic Settings tab wil display your Hive User Name, Hive Account/Level/Type, Registration Date and Time, and contact information. You can edit the organization and address for
your Hive account on this tab. After you modify settings, click Submit.

Basic Setting Security Setting

| Basic Setting

G User Name HOOCROOKN

oy Level XXHXNNNK

Registration Time  2020-10-20 17:43:58

| Contact Information

Email XX (DD KKK KKK
Organization TREMNDNEt, Inc.
Address

© Copyright 2021 TRENDnet. All Rights Reserved.
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To edit your Hive account password, click on the Security Settings tab.

The Safety Level indicates the current security level of your account based on the complexity of your current Hive account password.
Note: It is recommended to change your Hive account password with High security level rating.

Basic Setting Security Setting
| Safety Level
Security of your current account : Medium  Keep trying

| Security Setting

A password with high security can make an accouni safer. It is recommended that you change your password regularly and set a password that contains at least two
Passwaord - : :
kind of letters, symbols or numbers and is longer than 6 bits

Bind mailbox You have bound your mailbox, and the cloud service system sends log information to your Mailbox. [ oo @0eaoe. K

@ Already Set | Modify

© Already Set | Modify

Under the Security Setting section, for the Password setting, click on Modify to modify your Hive account password.

Password X

* Old Password samssssannn

" New Password D

* Confirm P —

© Copyright 2021 TRENDnet. All Rights Reserved.
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To change the email address your Hive account is associated, under the Security Setting section, for Bind mailbox, click on Modify to modify your Hive email address.
The current email address the Hive account is associated will be displayed in green.

Bind mailoox You have bound your mailbox, and the cloud service system sends log information to your mailbox. | woooocood@ocoooocood | @ Already Set | Modify

Enter the new email address in the field provided, then click Get Code to receive a verification from the Hive system at the new email address.
Check the new email mailbox and enter the verification code received in the field provided, then click Submit.

Bind mailbox X

* Email

Get Code

* Verification code

Submit Cancel
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Create Users and Assign Permissions

To modify your Hive personal account information, in the top right menu, click the Account/Logging button and click on User Management.

To add a new user, at the top, click the button.

Enter the user details such as User Name, Email, Password.

Add User

* User Name

™ Email

" Password

* Confirm

© Copyright 2021 TRENDnet. All Rights Reserved.
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Click the Function drop-down to select the Hive section the user will have access. Any sections not seletected will not be accessible for the new user.

Note: When checking sections, if dependency sections are required in order to access a selected section, a notification will appear in red indicating other specific dependencies that must
also be checked in order for the user to access selected section.

* Function Dashboard / Basic Tenant
+8
Flease chack Devices -= Device List = Devices List
" Tenant Dashboard > Device List >
[] Devices - Device Location >
Configuration >
Firmware 2
—

Click the Tenant drop-down list to select the specific tenant the user will have access. The user will only have access to the selected tenant. Then click Submit to create the new user.
Note: To allow the user access to all tenants, check the All option.

Tenant TENANT1 & All

TEMANTA o
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The new user will be displayed in the user list.

# User Name Email Greate Time Operation

1 HXHHNNNK OO0 E MO NN 2021-02-1017:42:21 ¢

b

Under the Operation section

"= . Edit the user account settings. Allows you to modify the user email, access sections, and issue a reset password.

|

- Delete the user account.
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View Hive System Messages

System messages related the Hive Management system internally. (ex: New device firmware update release in Hive Management System).
To view Hive system messages, click the Account/Logging button and click on Message List.

The system messages will display in the list.

Note: You can click on the Read Messages tab to view messages that have already been read or click the Unread Messages tab to view messages that not yet been read.

All Messages Fead Messages Unread Messages
Title Type Status Content Create Time Operation
Release a new version System Message Reac Model TPE-5048WS, TPE-204US TPE-082WS, TPE-1620. .. 2021-01-05 15:45:14 B m@
System maintenance System Message Read System restart 2020-12-23 02:11:24 B m

Under the Operation section for each message,

B

% - Click this button to delete the message.

- Click this button view the message details

At the top left of the page, you can click the Batch Operation to mark multiple messages as Read (Mark Read) or delete multiple messages (Batch Delete).

First, check all messages to apply the batch operation, then click the Batch Operation drop-down list and selected batch operation to use.

Mark Read

Batch Delete
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View Device Logging

To view Hive device logging, click the Account/Logging button and click on Device Log

This section displays device logging from devices managed from your Hive account.

At the top left, enter the keyword (if any) to search in device logging.

Select the Start Date and End Date range of device logging to display.

Note: Logging data is limited only to 30 days prior to the current date.

Click the Select Level drop-down list to select only specific types of logging to be displayed (optional, if none selected, logging will be displayed for all)
Click the Event Type drop-down list to select only specific events to be displayed (optional, if none selected, logging will be displayed for all)

Click Search to display logging within your defined filters.

After the search has completed, you can click Export to export logging to an excel (.xlsx) file.

: asom

# Update Time Model SN Tenant Level Event Type Content Operation
1 2021-02-10 14:03:52 TPE-2840WS SO INNNAX TEMNANTA Informational mes. .. Port Link Up Port 23 link up, 100Mbps FULL duplex o]
2 2021-02-10 14:03:50 TPE-2840WS JOOGOOCOOOX TENANTA Informational mes Port Link Down Port 23 link down T
3 2021-02-10 14:03:49 TPE-2840WS YOO TENANTA Informational mes...  Port Link Up Port 19 link up, 100Mbps FULL duplex jof
4 2021-02-10 14:03:48 TPE-2840WS HOOOOCOCOOOON TENANTA Informational mes. .. Port Link Down Port 19 link down o]

Under the Operation section for each log entry,

“ - Click this button to delete the logging entry.
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View System Logging

To view Hive system logging, click the Account/Logging button and click on System Log

This section displays Hive system logging of activity in your Hive account and alarm notifications.
At the top left, enter the keyword (if any) to search in system logging.

Select the Start Date and End Date range of system logging to display.

Note: Logging data is limited only to 30 days prior to the current date.

Click the Info Alarm drop-down list to select the class system logging to display.

Click Search to display logging within your defined filters.

After the search has completed, you can click Export to export logging to an excel (.xlsx) file.

to Info Alarm Q Search m

# Content Module Tenant Class Process Operator Create Time Operation
1 Get all Gontent successtully Message - Info - OGO 2021-02-10 18:19:04 ]
2 Change Content status successfully Message - Info - XOOOOCNNKK 2021-02-10 18:19:00 |
3 Get all Content successfully Message - Info - OO0 2021-02-10 18:18:18 ]
4 Change all Content status successiully Message - Info - JOOO00000M 20210210 18:18:18 T

Under the Operation section for each log entry,

~ - Click this button to delete the logging entry.
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Configure alert notifications
To configure alert notifications, in the top right menu.

Il @ & & 2°

Click the Alert Notifications button ﬂ and click on Alert Settings.

Click the drop-down list in the left to select which tenant to configure the alert notification settings.
Enable/disable alert notificatons for Mail Push for email notifications.
Enable/disable alert notificatons for App Push for mobile app notifications.

Note: Some alert settings require threshold percentages or data restrictions to be entered. You can also click the copy current configuration and apply link to apply the alert notification
settings to a different tenant.

© Tenant Alert Settings List
TENANT1 copy current configuration and apply
# Description Value Mail Push APP Push
1 devices offline alarm » »
2 all tenant devices offline
3 cpu usage over threshold more than 0 % @ C’ C’
4 memary usage over threshaold more than 0 % @ C’ C’
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Web Smart Switch Series Hardware Specifications

TEG-082WS (2.0R)

TEG-204WS (1.0R)

TEG-284WS (1.0R)

TEG-524WS (1.0R)

Device Interface

LED Mode select butt

on and LED indicators

8 x Gigabit ports

16 x Gigabit ports

24 x Gigabit ports

48 x Gigabit ports

2 x SFP slots 4 x Shared Gigabit ports (RJ-45/SFP)
Ethernet: 10 Mbps (half duplex), 20 Mbps (full duplex)
Data Transfer Rate Fast Ethernet: 100 Mbps (half duplex), 200 Mbps (full duplex)
Gigabit Ethernet: 2000 Mbps (full duplex)
Switch fabric 20 Gbps 40 Gbps 56 Gbps 104 Gbps
RAM buffer 4.1 Mbits 12 Mbits
MAC Address Table 8K entries 16K entries

Jumbo Frames

10 Kbytes

Forwarding

14.9Mpps (64-byte packet size)

29.8Mpps (64-byte packet size)

41.7Mpps (64-byte packet size)

77.4Mpps (64-byte packet size)

HOL Blocking Prevention

HOL Blocking Prevention

supported on all models

Power Input

100 - 240V AC, 50/60 Hz, internal power supply

Power Consumption

7.1 Watts (max.)

14.6 Watts (max.)

17.3 Watts (max.)

34.9 Watts (max.)

Fan Quantity

Fan

less

Noise Level

N/A (fanless)

MTBF

1,092,872 hours

835,519 hours

787,004 hours

400,158 hours
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TEG-082WS (2.0R)

TEG-204WS (1.0R)

TEG-284WS (1.0R)

TEG-524WS (1.0R)

Operating Temperature

-5°—50°C (23° - 122°F)

Operating Humidity

Max. 95% non-condensing

280 x 125.8 x 44 mm 280 x 180 x 44 mm 440 x 140 x 44mm 440 x 210 x 44mm
I e (11x5x1.74in.) (11x7x1.74in.) (17.4x5.51x1.74in.) (17.3x8.3x1.74in.)
Rack mountable 1U height

Weight 0.98 kg (2.2 lbs.) 1.76 kg (3.88 Ibs.) 2.15 kg (4.73 Ibs.) 3.48 kg (7.67 Ibs.)
CE
Certifications FCC
uL

Warranty Lifetime

In addition to the switch, the package contents include the following:

Quick Installation Guide

Package Contents
Rack mount kit

Power cord (1.8m/6 ft.)

*Model requires update to firmware 3.01.XXX to enable Hive capability.

© Copyright 2021 TRENDnet. All Rights Reserved.
50


http://www.trendnet.com/support/view.asp?cat=4&id=8

TRENDnet User’s Guide

Web Smart Switch Series Software Specifications
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Standards

IEEE 802.1d
IEEE 802.1p
IEEE 802.1Q
IEEE 802.1s
IEEE 802.1w

IEEE 802.1X
IEEE 802.1ab
IEEE 802.3
IEEE 802.3u
IEEE 802.3x

IEEE 802.3z

IEEE 802.3ab
IEEE 802.3ad
IEEE 802.3az

Management

CLI (Telnet / SSHv2) for basic
administration

HTTP/HTTPS (SSL v2/3 TLS) Web based
GUI

SNMP v1, v2c, v3

RMON v1

Static Unicast MAC Address
Enable/disable 802.3az Power Saving
LLDP and LLDP-MED

Virtual Cable Diagnostics Test

IPv6: IPv6 Neighbor Discovery, IPv6
Static IP, DHCPv6, Auto configuration
Dual image and configuration

TC Root/Protect

Hive Cloud Management

(requires update to
firmware 3.01.XXX to
enable Hive capability)

Configure, monitor, and manage
through the TRENDnet Hive Cloud
Management Portal remotely via PC or
Mac web browser

Multi-device management
Provisioning through scheduled batch
firmware or configuration updates for
multiple switches

Enable & disable PoE, set PD (powered
device) alive check, configure PoE
scheduling, and monitor PoE budget
utilization (for PoE switches only)
Event/hardware network monitoring
(CPU/memory utilization)

Configure features such as IP address
settings, VLANSs, spanning tree,

loopback detection, IGMP snooping, link

aggregation, and bandwidth control
through cloud management

MiB

IP Forward Table MIB RFC 1354
RMON MIB RFC 1271

IPv4 MIB RFC 1213

IPv6é MIB RFC 2465

GVRP MIB IEEE 802.1Q-VLAN
LA MIB IEEE 802.3ad

LLDP MIB IEEE 802.1ab

IGMP Snooping MIB RFC 2933
MLD Snooping MIB RFC 3019
Private VLAN MIB IEEE 802.1Q

DHCP Snooping MIB RFC 2026
QoS MIB RFC 4323

SNMP MIB RFC 3415

STP MIB RFC 4318

PNAC MIB IEEE 802.1x

VLAN MIB IEEE 802.1q

DNS MIB RFC 1611

ACL MIB

Bandwidth CTRL MIB

LBD MIB

Mirror MIB

IPv6 Neighbor MIB
SNTP MIB

Storm CTRL MIB
Statistics MIB
Tool MIB

Voice VLAN MIB
DoS MIB

Spanning Tree

IEEE 802.1D STP (Spanning Tree
protocol)

IEEE 802.1w RSTP (Rapid Spanning Tree
protocol)

IEEE 802.1s MSTP (Multiple Spanning
Tree protocol)

Link Aggregation

Static Link Aggregation

802.3ad Dynamic LACP
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Hive Management System

e 802.1p Class of Service (CoS) e Bandwidth Control per port e Queue Scheduling: Strict Priority,
Quality of Service (QoS) o  DSCP (Differentiated Services Code Weighted Round Robin (WRR)
Point)
e Multiple management VLAN assignment e  Dynamic GVRP e Upto 256 VLAN groups, ID Range 1-
e  Asymmetric VLAN e MAC-based VLAN 4094
VLAN e 802.1Q Tagged VLAN e Protocol-based VLAN e  Private VLAN (Protected Ports)
e  Voice VLAN (10 user defined OUls)
Iti e IGMP Snooping v1, v2, v3 e IGMP fast leave e  Static Multicast Address
Multicast e MLD Snooping v1, v2 e  MVR (Multicast VLAN Registration) e Up to 256 multicast entries
Port Mirror e RX, TX, or Both * Manytoone
e 802.1X Port-Based Network Access e Duplicated Address Detection e  Dynamic ARP inspection
Control , RADIUS, TACACS+ e Trusted Host e  Block unknown multicast
Access Control e Local Dial In User Authentication e Denial of Service (DoS)

e DHCP Snooping (per VLAN) e IPMAC port binding
e Loopback Detection
e MAC Address e IP Protocol 0-255 e DSCP (IPv4 only)

ACL IPv4 L2-L4 & IPv6 e VLANID e TCP/UDP Port 1-65535 e |Pv6 Address (IPv6 only)
e Ether Type (IPv4 only) e 802.1p
e IPv4 / IPV6 static routing e Routing table entries: Up to 32 (IPv4 / e Inter-VLAN routing

Layer 3 Features e IPinterfaces: Up to 6 IPvé)
e  ARP table (up to 128 entries)
Compatibility Optional Software Utility: Windows® 10, 8.1, 8, 7, Vista, XP, Windows® 2003/2008 Server
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Hive Management System

Web Smart PoE Switch Series Hardware Specifications

TPE-082WS*
(1.0R)

TPE-1620WSF* TPE-2840WS* TPE-5028WS*
(1.0R) (2.0R) (1.0R)

TPE-1620WS*
(2.0R)

TPE-5240WS*
(1.0R)

TPE-5048WS*
(1.0R)

Device Interface

LED Mode select button and LED indicators

8 x Gigabit PoE+

16 x Gigabit PoE+ ports 24 x Gigabit PoE+ ports

48 x Gigabit PoE+ ports

ports
2 x SFP slots 4 x Shared Gigabit ports (RJ-45/SFP)
Ethernet: 10 Mbps (half duplex), 20 Mbps (full duplex)
Data Transfer Rate Fast Ethernet: 100 Mbps (half duplex), 200 Mbps (full duplex)
Gigabit Ethernet: 2000 Mbps (full duplex)

Switch fabric 20 Gbps 40 Gbps 56 Gbps 104 Gbps

RAM buffer 4.1 Mbits 12 Mbits
MAC Address Table 8K entries 16K entries

Jumbo Frames

10 Kbytes

14.9 Mpps (64-byte

Forwarding packet size) 29.8Mpps (64-byte packet size) 41.7Mpps (64-byte packet size) 77.4Mpps (64-byte packet size)
HOL Bloc!(lng HOL Blocking Prevention supported on all models
Prevention

External power

Power Input supply (54V DC, 100 - 240V AC, 50/60 Hz, internal power supply
1.67A)
Power
. 82 Watts (max.) 226W (max.) 460W (max.) 256W (max.) 446W (max.) 479W (max.) 963W (max.)
Consumption
PoE Type 802.3at: Up to 30W per port
PoE Budget 75 Watts 185w 370W 185W 370W 740W 75 Watts

Fan Quantity Fanless 2 3 5

Noise Level

N/A (fanless)

52 dBA (max.)

52.4 dBA (max.)

55 dBA (max.)

MTBF

862,966 hours

465,862 hours 192,382 hours 443,825 hours 277,604 hours

239,897 hours

338,601 hours
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TPE-082WS* TPE-1620WS* TPE-1620WSF* TPE-2840WS* TPE-5028WS* TPE-5240WS* TPE-5048WS*
(1.0R) (2.0R) (1.0R) (2.0R) (1.0R) (1.0R) (1.0R)
Operating -5°—=50°C(23° - 122°F)
Temperature
0, -
Operating Humidity Max. 95% non-condensing Max. 90% .non Max. 95% non-condensing
condensing
280x125.8 x 44
. ., mm (11x5x 1.74 440 x 250 x 44mm (17.3x9.8 x 1.74 in.) 440 x 430 x 44mm (17.3x 17 x 1.74 in.)
Dimensions in.)
Rack mountable 1U height
Weight 0.92 kg (2 Ibs.) 3.66kg (8 Ibs.) 3.89kg (8.5 Ibs.) 3.75kg (8.26 lbs.) 3.92kg (8.64 lbs.) 6.12kg (13.5 Ibs.) 6.58kg (14.5 Ibs.)
CE
Certifications Fec
External Power uL
Adapter (UL)
Warranty Lifetime
In addition to the switch, the package contents include the following:
Quick Installation Guide
Package Contents Rack mount kit
Power adapter (54V
DC, 1.67A) Power cord (1.8m/6 ft.)

*Model requires update to firmware 3.01.XXX to enable Hive capability.
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Hive Management System

Web Smart PoE Switch Series Software Specifications

GUI
SNMP v1, v2c, v3
RMON v1

Virtual Cable Diagnostics Test

IEEE 802.1d IEEE 802.1ab IEEE 802.3ad
IEEE 802.1p IEEE 802.3 IEEE 802.3af
IEEE 802.1Q IEEE 802.3u IEEE 802.3at
Standards IEEE 802.1s IEEE 802.3x IEEE 802.3az
IEEE 802.1w IEEE 802.3z
IEEE 802.1X IEEE 802.3ab
CLI (Telnet / SSHv2) for basic Static Unicast MAC Address IPv6: IPv6 Neighbor Discovery, IPv6
administration Enable/disable 802.3az Power Saving Static IP, DHCPv6, Auto configuration
LLDP and LLDP-MED Dual image and configuration
Management HTTP/HTTPS (SSL v2/3 TLS) Web based g g

TC Root/Protect

Hive Cloud Management

(requires update to
firmware 3.01.XXX to
enable Hive capability)

Configure, monitor, and manage
through the TRENDnet Hive Cloud
Management Portal remotely via PC or
Mac web browser

Multi-device management
Provisioning through scheduled batch
firmware or configuration updates for
multiple switches

Enable & disable PoE, set PD (powered
device) alive check, configure PoE
scheduling, and monitor PoE budget
utilization (for PoE switches only)
Event/hardware network monitoring
(CPU/memory utilization)

Configure features such as IP address
settings, VLANSs, spanning tree,
loopback detection, IGMP snooping, link
aggregation, and bandwidth control
through cloud management

MiB

IP Forward Table MIB RFC 1354
RMON MIB RFC 1271

IPv4 MIB RFC 1213

IPv6 MIB RFC 2465

GVRP MIB IEEE 802.1Q-VLAN
LA MIB IEEE 802.3ad

LLDP MIB IEEE 802.1ab

IGMP Snooping MIB RFC 2933
MLD Snooping MIB RFC 3019
Private VLAN MIB IEEE 802.1Q

DHCP Snooping MIB RFC 2026
QoS MIB RFC 4323

SNMP MIB RFC 3415

STP MIB RFC 4318

PNAC MIB IEEE 802.1x

VLAN MIB IEEE 802.1q

DNS MIB RFC 1611

ACL MIB

Bandwidth CTRL MIB

LBD MIB

Mirror MIB

IPv6 Neighbor MIB
SNTP MIB

Storm CTRL MIB
Statistics MIB
Tool MIB

Voice VLAN MIB
DoS MIB

Spanning Tree

IEEE 802.1D STP (Spanning Tree
protocol)

IEEE 802.1w RSTP (Rapid Spanning Tree
protocol)

IEEE 802.1s MSTP (Multiple Spanning
Tree protocol)

Link Aggregation

Static Link Aggregation

802.3ad Dynamic LACP
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Hive Management System

e 802.1p Class of Service (CoS) e Bandwidth Control per port e Queue Scheduling: Strict Priority,
Quality of Service (QoS) e  DSCP (Differentiated Services Code Weighted Round Robin (WRR)
Point)
e Multiple management VLAN assignment e  Dynamic GVRP e Upto 256 VLAN groups, ID Range 1-
e Asymmetric VLAN e MAC-based VLAN 4094
VLAN e 802.1Q Tagged VLAN e Protocol-based VLAN e  Private VLAN (Protected Ports)
e Voice VLAN (10 user defined OUlIs)
X e IGMP Snooping v1, v2, v3 e IGMP fast leave e  Static Multicast Address
Multicast e MLD Snooping vi, v2 e MVR (Multicast VLAN Registration) e Upto 256 multicast entries
Port Mirror e RX, TX, or Both * Manytoone
e 802.1X Port-Based Network Access e Duplicated Address Detection e Dynamic ARP inspection
Control , RADIUS, TACACS+ e  Trusted Host e  Block unknown multicast
Access Control e Local Dial In User Authentication * Denial of Service (DoS)

e DHCP Snooping (per VLAN) * IP MAC port binding
e Loopback Detection
e MAC Address e IP Protocol 0-255 e  DSCP (IPv4 only)

ACL IPv4 L2-L4 & IPv6 e VLANID e TCP/UDP Port 1-65535 e |Pv6 Address (IPv6 only)
e Ether Type (IPv4 only) e 802.1p
e IPv4 / IPV6 static routing e Routing table entries: Up to 32 (IPv4 / e Inter-VLAN routing

Layer 3 Features e IPinterfaces: Up to 6 IPvé)
e ARP table (up to 128 entries)
Compatibility Optional Software Utility: Windows® 10, 8.1, 8, 7, Vista, XP, Windows® 2003/2008 Server
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Limited Warranty

Limited Warranty

TRENDnet warrants only to the original purchaser of this product from a TRENDnet
authorized reseller or distributor that this product will be free from defects in material
and workmanship under normal use and service. This limited warranty is non-
transferable and does not apply to any purchaser who bought the product from a
reseller or distributor not authorized by TRENDnet, including but not limited to

purchases from Internet auction sites.

Limited Warranty

TRENDnet warrants its products against defects in material and workmanship, under
normal use and service. Specific warranty periods are listed on each of the respective

product pages on the TRENDnet website.

e AC/DC Power Adapter, Cooling Fan, and Power Supply carry a one-year

warranty.

Limited Lifetime Warranty

TRENDnet offers a limited lifetime warranty for all of its metal-enclosed network
switches that have been purchased in the United States/Canada on or after 1/1/2015.

e Cooling fan and internal power supply carry a one-year warranty

To obtain an RMA, the ORIGINAL PURCHASER must show Proof of Purchase and return
the unit to the address provided. The customer is responsible for any shipping-related
costs that may occur. Replacement goods will be shipped back to the customer at
TRENDnet’s expense.

Upon receiving the RMA unit, TRENDnet may repair the unit using refurbished parts. In
the event that the RMA unit needs to be replaced, TRENDnet may replace it with a
refurbished product of the same or comparable model.

In the event that, after evaluation, TRENDnet cannot replace the defective product or
there is no comparable model available, we will refund the depreciated value of the
product.

If a product does not operate as warranted during the applicable warranty period,
TRENDnet shall reserve the right, at its expense, to repair or replace the defective
product or part and deliver an equivalent product or part to the customer. The
repair/replacement unit's warranty continues from the original date of purchase. All
products that are replaced become the property of TRENDnet. Replacement products
may be new or reconditioned. TRENDnet does not issue refunds or credit. Please

contact the point-of-purchase for their return policies.

TRENDnet shall not be responsible for any software, firmware, information, or memory
data of customer contained in, stored on, or integrated with any products returned to

TRENDnet pursuant to any warranty.

There are no user serviceable parts inside the product. Do not remove or attempt to
service the product by any unauthorized service center. This warranty is voided if (i) the
product has been modified or repaired by any unauthorized service center, (ii) the
product was subject to accident, abuse, or improper use, or (iii) the product was subject

to conditions more severe than those specified in the manual.

Warranty service may be obtained by contacting TRENDnet within the applicable
warranty period and providing a copy of the dated proof of the purchase. Upon proper
submission of required documentation, a Return Material Authorization (RMA) number
will be issued. An RMA number is required in order to initiate warranty service support
for all TRENDnet products. Products that are sent to TRENDnet for RMA service must
have the RMA number marked on the outside of return packages and sent to TRENDnet

prepaid, insured and packaged appropriately for safe shipment. International customers
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shipping from outside of the USA and Canada are responsible for any return shipping

and/or customs charges, including but not limited to, duty, tax, and other fees.

Refurbished product: Refurbished products carry a 90-day warranty after date of
purchase. Please retain the dated sales receipt with purchase price clearly visible as
evidence of the original purchaser's date of purchase. Replacement products may be
refurbished or contain refurbished materials. If TRENDnet, by its sole determination, is
unable to replace the defective product, we will offer a refund for the depreciated value

of the product.

WARRANTIES EXCLUSIVE: IF THE TRENDNET PRODUCT DOES NOT OPERATE AS
WARRANTED ABOVE, THE CUSTOMER'S SOLE REMEDY SHALL BE, AT TRENDNET'S
OPTION, REPAIR OR REPLACE. THE FOREGOING WARRANTIES AND REMEDIES ARE
EXCLUSIVE AND ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED,
EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
TRENDNET NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR
IT ANY OTHER LIABILITY IN CONNECTION WITH THE SALE, INSTALLATION,
MAINTENANCE, OR USE OF TRENDNET'S PRODUCTS.

TRENDNET SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING AND
EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST
OR WAS CAUSED BY CUSTOMER'S OR ANY THIRD PERSON'S MISUSE, NEGLECT,
IMPROPER INSTALLATION OR TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR OR
MODIFY, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY
ACCIDENT, FIRE, LIGHTNING, OR OTHER HAZARD.

LIMITATION OF LIABILITY: TO THE FULL EXTENT ALLOWED BY LAW, TRENDNET ALSO
EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY LIABILITY, WHETHER BASED IN

CONTRACT OR TORT (INCLUDING NEGLIGENCE), FOR INCIDENTAL, CONSEQUENTIAL,
INDIRECT, SPECIAL, OR PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE OR
PROFITS, LOSS OF BUSINESS, LOSS OF INFORMATION OR DATE, OR OTHER FINANCIAL
LOSS ARISING OUT OF OR IN CONNECTION WITH THE SALE, INSTALLATION,
MAINTENANCE, USE, PERFORMANCE, FAILURE, OR INTERRUPTION OF THE POSSIBILITY
OF SUCH DAMAGES, AND LIMITS ITS LIABILITY TO REPAIR, REPLACEMENT, OR REFUND
OF THE PURCHASE PRICE PAID, AT TRENDNET'S OPTION. THIS DISCLAIMER OF LIABILITY
FOR DAMAGES WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN SHALL FAIL
OF ITS ESSENTIAL PURPOSE.

Governing Law: This Limited Warranty shall be governed by the laws of the state of

California.

Some TRENDnet products include software code written by third party developers.
These codes are subject to the GNU General Public License ("GPL") or GNU Lesser
General Public License ("LGPL").

Visit http://www.trendnet.com/gpl or the support section on
http://www.trendnet.com and search for the desired TRENDnet product to access to
the GPL Code or LGPL Code. These codes are distributed WITHOUT WARRANTY and are
subject to the copyrights of the developers. TRENDnet does not provide technical
support for these codes. Please visit http://www.gnu.org/licenses/gpl.txt or

http://www.gnu.org/licenses/Igpl.txt for specific terms of each license.
PWP07172015v3 2021/02/10
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TRENDNET

Product Warranty Registration

Please take a moment to register your product online.
Go to TRENDnet's website at http:/ /www.trendnet.com /register

Please ensure your switch's firmware version is V2.10.010 or newer for full support of
Layer 2+ management features. See the Firmware Upgrade section in this document for
additional information regarding the firmware upgrade procedure.

TRENDnNet
20675 Manhattan Place
Torrance, CA 90501. USA
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